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Finding Census Blocks with QGIS FCC Form 477 

What is QGIS & Why is it Useful? 
 

QGIS is a free, open-source geographic information system (GIS) software package you can use to create, 
analyze, and process geographic data.  This software is particularly relevant to FCC Form 477 because it 

can be used to create the list of census blocks that best represent the broadband deployment footprint of 

your company for the Fixed Broadband Deployment section of the form.1   

 

You can use QGIS to create a list of blocks based on an area or areas you draw on the map yourself, or 
from existing GIS-compatible map files (a shapefile, for example).  This guide explains how to use QGIS 

to draw an area on a map and enumerate the list of census blocks that are either entirely or partially 

contained therein.  QGIS is not the only software that can do this.2  

 

This example utilizes 2010 data for example purposes. You would use 2020 Census data for any 

filings beginning with the December 31, 2021 filing period. Note that you must use 2020 
geographies. 

 

How to… 
 

Here’s an example of how to generate a list of blocks from an area you draw on a map.  This covers the 

whole process, from downloading and installing the software to offloading the results to Excel.   
 

1. Download and Install QGIS from http://qgis.org/en/site/forusers/download.html.  Note: you 

may need administrative rights to install the software. 

 

A. Mac 
Note: you may need to temporarily change your security permissions the first time you 

run the program 

i. Download the GDAL Complete package from 

http://www.kyngchaos.com/software/frameworks#gdal_complete 

(http://www.kyngchaos.com/files/software/frameworks/GDAL_Complete-

1.11.dmg).  GDAL (Geospatial Data Abstraction Library) is a translator library 
for geospatial data formats and QGIS for Mac will not run without it. 

ii. Download QGIS from http://www.kyngchaos.com/software/qgis 

(http://www.kyngchaos.com/files/software/qgis/QGIS-2.4.0-1.dmg) 

iii. Double-click each dmg file to mount it. 

iv. Double-click the GDAL Complete.pkg and the NumPY.pkg; and follow the 
instructions from the installer. 

v. Double-click the Install QGIS.pkg and follow the instructions from the installer. 

 

 
1 Recall that facilities-based providers of fixed broadband Internet access must report a list – uploaded as a 
delimited, plain text / CSV file – of all census blocks in which the filer (including affiliates) makes broadband 

connections available to end-user premises.  For more information about this requirement, see Section 5.3 of the 
Form 477 Instructions. 
 
2 The choice by staff to use certain software packages and references in creating the illustration below does not 
imply the endorsement, approval, or authorization of the software packages or references by the FCC.  The FCC 

does not endorse or recommend any particular product or application for creating a list of census blocks to submit as 
part of the Form 477 data collection.  Rather, the following illustration is intended only to give an example of how a 
service provider can generate a list of census block IDs that can be used in conjunction with the Form 477 filing 

process and should not be construed as an endorsement or warranty of any particular software package or reference. 

http://qgis.org/en/site/forusers/download.html
http://www.kyngchaos.com/software/frameworks#gdal_complete
http://www.kyngchaos.com/files/software/frameworks/GDAL_Complete-1.11.dmg
http://www.kyngchaos.com/files/software/frameworks/GDAL_Complete-1.11.dmg
http://www.kyngchaos.com/software/qgis
http://www.kyngchaos.com/files/software/qgis/QGIS-2.4.0-1.dmg
http://transition.fcc.gov/form477/477inst.pdf
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B. Windows 

i. Download the installer file appropriate for your computer (either 32-bit or 64-bit; 
either Stand-alone or Network) and follow the instructions from the installer. 

 

2. Download census block boundaries from U.S. Census (TIGER shapefiles for block 

geometries).  Note that you must use 2010 geographies for this example. 

 
A. Go to https://www.census.gov/geo/maps-data/data/tiger-line.html 

B. Click on the 2010 tab and then click Download.  You must use 2010 geographies. 

C. Click on FTP Site (files arranged by state and county FIPS codes) or Web Interface.  

Either method will allow a download of an entire state or a county within a state.  The 

files on the FTP Site are named by state and county FIPS codes, so consult our County 

File Reference and State File Reference to determine which files you need.  
D. Download the zip file associated with the state(s) or counties of interest. 

i. Mac: drag the zip file to a convenient location. 

ii. Windows: after clicking the link to the zip file, a dialog box will open.  Save the 

file to a convenient location. 

E. Optional: From the 2010 tab, you can also click on Special Release and follow the 
instructions to access 2010 block shapes linked with the select demographic data 

described (ftp://ftp2.census.gov/geo/tiger/TIGER2010BLKPOPHU/).  You can only 

download state-level data (use the lookup table below to see what state is appropriate).  

 

3. Open QGIS and enable a “base layer” road map to help identify landmarks and areas of interest.  
You may choose any street map, or none at all; the directions below enable Google Streets as the 

base layer. 

 

A. From the Plugins menu, click Manage and Install Plugins… 

 

 

 

B. Search for OpenLayers Plugin; click Install plugin.  Close the Plugins window. 

 

https://www.census.gov/geo/maps-data/data/tiger-line.html
http://www.fcc.gov/form477/Geo/tiger_2010_block_boundary_files_county.pdf
http://www.fcc.gov/form477/Geo/tiger_2010_block_boundary_files_county.pdf
http://www.fcc.gov/form477/Geo/tiger_2010_block_boundary_files_state.pdf
ftp://ftp2.census.gov/geo/tiger/TIGER2010BLKPOPHU/
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C. Under the Web menu, click OpenLayers plugin and click Add Google Streets layer.  Note 
that the OpenLayers plugin menu may be in different places in different versions of 

QGIS. 

 

 

 

4. Load the block map for the county or state you downloaded. 

 
A. Unzip the zip file you downloaded into a convenient directory. 

B. In QGIS, browse to the directory into which you extracted the zip file and double-click 

on the .shp file to open it in QGIS. 

C. Right click on the block layer in the left-hand menu and click on Zoom to Layer Extent to 

zoom to where the blocks shapes are located. 
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D. Each of these steps can take some time to process. 

E. If the block shapes do not appear, you may need to zoom the map to the correct location.  
Use the “zoom to layer” option by right-clicking on the layer and hitting Zoom to Layer. 

 

 
 

F. The block shapes could also be behind the street maps.  If so, go to the Layers menu and 

drag the block layer to the top of the list. 

G. Optional: modify the display of the block shapes to make it easier to see both the blocks 

and the underlying base map. 

i. Make the block layer semi-transparent so you can see the underlying street map.   
1. Double-click the block map layer. 

2. Click on the Style tab. 

3. Slide the Layer transparency slider to 50-90%. 
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4. Click OK. 

ii. Differentiate blocks that are all water from those that include at least some land. 

1. Double-click the block map layer. 

2. Click on the Style tab. 
3. Click on the pull-down menu on the left that says Single Symbol and 

change it to Categorized. 

4. Click on the pull-down menu to the right of Column and choose 

ALAND10 (land area 2010). 

5. Click Add below the large window. 
6. Click on the Value column, type in 0.  Click on the Label column and 

type in Water. 

7. Click on the small colored box on the left and pick a color for water. 

8. Repeat the process: click Add but this time, leave the Value column 

blank; Click on the Label column and type in Land; pick a color for land. 
9. Hit OK. 
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5. Load or create a shapefile that represents your service area. 

 

A. If you have a shapefile already (e.g., if you have submitted shapefiles as part of the SBI 
or another data collection), load that shapefile into QGIS. 

Note: representing the spherical shape of the surface of the earth on a flat map requires 

projecting data from the three-dimensional source to the two-dimensional map.  The U.S. 

Census shapefiles were created using ESPG: 4269 – NAD83 while Google Streets uses 

EPSG: 38578 – WGS 84 /Pseudo Mercator.  If your shapefile was created with a 
different projection, QGIS will overlay it onto the blocks; but it is possible that the 

different projection will lead the shape to shift or change shape; please confirm that the 

shape still represents the area of interest. 

i. Browse to and double click on the .shp file. 

ii. Confirm that the shape represents the area of interest. 

B. If you do not already have a shapefile, you can “draw” one onto the map using one of the 
QGIS tools. 

i. From the Layer menu, click New then New Shapefile Layer.   
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ii. In the dialog box that opens, click polygon.  Name the shape and hit OK.  Find a 

place to store the shapefile of this new layer, name it, and hit OK.  

Note: these instructions leave the default projection as EPSG: 4326 – WGS 84.  

You can use other projections but please confirm that the final shape represents 
the area of interest. 
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iii. Turn on editing using the Layer menu; or by right-clicking on the shape and 
clicking on Toggle Editing; or by clicking on the Toggle Editing button (shaped 

like a pencil). 
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iv. Click on Edit and then Add Feature. 
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v. On the map, click on the points that outline the shape (the outline of the shape 
may appear odd as you create it).  Right click at the last point to close the shape.   

vi. Type in an id for this shape (like “1”). 

vii. You can change the appearance of this shape as you did for the census block 

shapes if desired. 

viii. You can edit the shape by clicking on Node Tool (on the Edit menu).  If helpful, 
you can zoom in on the area of interest to better see the streets and other features.   

1. You can move the end points (nodes) by clicking and dragging them.    

2. You can also move lines (edges) by clicking and dragging them.   

3. Double click on a line to add a new node. 

4. Click to highlight a node and hit the ‘delete’ key to remove a node.  

ix. You can create additional shapes if needed (e.g., if you have multiple service 
areas) with different id numbers. 

x. Turn off editing mode by clicking on Toggle Editing. 

xi. Save the changes to the shape. 

 

6. Intersect your service area with census block boundaries to identify which blocks intersect the 
service-area shape in whole or in part. 

 

A. Click on Vector then Geoprocessing Tools then Intersect. 

 

 

 

B. Select the shape that represents the area of interest in the top pull-down menu (the first 
Input Vector Layer). 

C. Select the block layer in the second pull-down menu. 

D. Click  the Browse button to find a location to store the intersected shape and hit Save. 

E. Click on Add result to canvas. 
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F. Then click OK.  The process could take several minutes to complete.  You won’t see any 

feedback from QGIS while processing is occurring. 

G. Click Close. 

H. When the process is complete you should see a new shape with the outline of the shape 
you created with internal lines showing the block boundaries. 
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I. You may need to turn off the service shape you loaded and the block layer to see the 
result. 

 

7. Copy the list of blocks to the program of your choice to create the file to submit to FCC as part 

of the Form 477 data collection. 

 
A. Option one: save the attribute table as a Comma Separated Value (CSV) file 

You will need to follow the instructions below to open this .csv file in Excel or another 

spreadsheet program without corrupting the census block codes. 

i. Right click on the newly created intersection shape and choose Save As… 
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ii. Select Comma Separated Value and choose a file name and location to save the 

.csv file.  This will save only information from the attribute table (including the 
information of interest about Census block IDs), but will not save the geometry 

information. 

 
 

B. Option two: copy and paste information from the attribute table into the program of your 

choice 

Pasting census block IDs into spreadsheet programs like Excel can corrupt the block 

codes.  Please read the instructions below to avoid such problems. 

i. Make sure QGIS will include only the information shown on the attribute table 
and not the geometry when you copy.  As shown below, go to Options… and 

select the Data Sources tab.  Make sure the box next to “Copy geometry in WKT 

representation from attribute table” is NOT checked.  Click OK. 
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ii. Right click on the newly created intersection layer. 
iii. Click on Open Attribute Table.  The first field shows the name of the service area 

polygon (we suggested the name “1” above).  The remaining fields show 

information from the census block map file you downloaded from TIGER. 

 

 

iv. The field of most interest is titled GEOID10.  This is the full 15-digit census 

block code for each block that intersected, in whole or in part, the service area(s) 

you created in step 5.B above.  You need the full 15-digit code (not the four-
digit BLOCKCE10 or NAME10 fields). 

v. Select all rows by clicking in the upper-left-hand box just above the data (the 

corner above the row labels and column labels).  Copy the data to the Clipboard 

by typing Command-C or Ctrl-C or hitting the Copy button.  Note that it can take 

some time for the information to be copied. 

 
 

 

 

 

 
 

 

 

 

 
 

 

 

 

 

 



 
 

Modified 11/18/2021 10:45 AM  Page 16 of 21 

Finding Census Blocks with QGIS FCC Form 477 

 

 

 

vi. Paste into a file where you can access the data to prepare the filing. 
vii. After copying the data, hit Unselect all (Command-U or Ctrl-U) to remove the 

highlighting. 

 

8. Save the Project to maintain all this work and revisit it later. 

 

9. Read the list of blocks into the program of your choice, either by opening the .csv file you 
created or by pasting the table you copied.   

 

Spreadsheet programs like Excel can corrupt the census block codes because they tend to treat 

them as numbers by default.  Leading zeroes are dropped (so the state FIPS code for Alabama 

appears as "1" instead of "01" and 15-digit block codes are often converted into scientific notation 
(ending with E+13 or E+14).  Once the format of the block codes has been changed in these 

ways, it is very difficult to change back to the proper display.  The instructions below will help 

avoid these problems.   

 

Census block codes must match across every digit.  When you submit census block codes, 
ensure that they display correctly with all 15 digits visible. 

A. When pasting data into a workbook... 

i. If you know which columns will contain the geography code or codes, highlight 

the column(s) by clicking on the header (the cell at the top with the letter), then 

select Text as the format. 

ii. If you do not know which columns will contain the geography code or codes, 
paste the data into the spreadsheet and find the columns.  Click on the header(s) 

and select Text as the format.  This adjusts the format for the column but does 

not correct the conversion that has already taken place.  Therefore paste the data 

into the spreadsheet again and confirm that all the geography codes are properly 

displayed. 
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After you change the column type to Text and paste in the data from the QGIS 

attribute table, Excel may warn you that you have a number stored as text; this is 
fine. 
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B. When opening a CSV file containing a list of census block codes... 

i. Opening the file directly (either by using the Open... command or double-

clicking the file itself) leads to the problematic default treatment of geography 

codes. Instead use the Import... command.  
ii. Click on Import..., select CSV, and hit OK.  
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iii. Select the file and follow the instructions of the Text Import Wizard.  First, 

choose Delimited. 
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Then make sure the box next to Comma is checked. 

 
Then find the column that contains the census block code, called GEOID.  You 

will probably have to scroll to the right.  Highlight that column and click the 

radio button next to Text.  Click Finish. 
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iv. Tell Excel where you want the new table to open and click OK. 


